Mail Merge Tutorial
(for Word 2003-2007)

What is mail merge?

You've probably heard it mentioned around the office or at an interview (especially for a
temp agency). You may have heard it referred to with an almost mystical quality.

So, what is mail merge exactly? Quite simply, it is a way of placing content from a
spreadsheet, database, or table into a Microsoft Word document. Mail merge is ideal for
creating personalized form letters or labels instead of editing the original letter several
times to input different personalized information. As you can imagine, this can save a
lot of time as well as worry about not changing all of the information for the new
recipient.

In order to create a mail merge, two documents are needed: a Word document and a
file with the data or records. This file can take many forms, such as an Excel
spreadsheet, a database, or even another Word document that has a table in it. In this
tutorial I will be using an Excel spreadsheet.

At the end of this tutorial, you should be able to:
1. Create a new mail merge from a document and a data source using the PC Mail
Merge Sidebar Wizard.
2. Edit an existing merged document using the Mail Merge Toolbar or Mailings Tab.
3. Get a taste for creating and editing mail merge on a Mac.

This tutorial assumes a basic proficiency with Word and Excel.



Part I: Creating Mail Merge on a PC using the Mail Merge Sidebar Wizard

Before creating a mail merge, it is important to already have your data source ready.
Although it is not necessary, | have found that it is easiest to have your Word document
set up beforehand as well. Therefore, | have already created a form letter in Microsoft
Word and entered my data into a Microsoft Excel spreadsheet.

Here is what my spreadsheet looks like. | used the first row to name my fields and
entered the appropriate data in the rows below. As you will see later, naming your rows
is very important when it comes to using mail merge. Also, notice how there are two
worksheets in my spreadsheet; this will also be important later.

A | B | C [ D [ E [ F 1 G | H l I =
1 First Name Last Name Address1 Address2 City State Zip Donation amt # of Tickets
2 |Lee Adama 9887 Gemenon St Galactica BS 45125 $ 550.00 1
3 |Kaylee Frye 607 Airlock St Apt 4 Serenity FF 01111 $ 100.00 2
4 |Sora Heart 522 Kairi Blvd Disney WD 799999 $ 100.00 1
5 |Tidus Jecht 74 Yuna St Apt 22 Square FF 02200 $ 100.00 1
6 |Mickey & Minnie Mouse 1 Disney St Disney WD 99999 $ 5,000.00 4
7 |Mal Renyolds 607 Airlock St Apt 1 Serenity FF 01111 $ 25075 1
8 |Luke Skywalker 23 Hoth Way Dagoba sw 76767 $ 1,000.00 1
9 |Leia Skywalker 25 Hoth Way Dagoba sw (76767 $  1,250.00 3
10 |Cara Thrace 368 Caprica Ave Apt 435 Galactica BS 45125 $ 200.50 2
11 [Simon Tam 607 Airlock St Apt 8 Serenity FF 01111 $ 2,000.00 2 v
4 » )\ donors 2006 { Sheet2 / |< Sl

Giant Corporation
332 Something Circle

This is my Word document. As you Somewhere, ST 55555
can see, when | created the letter, |
used < > to mark where | want
variable content to be placed and

February 2, 2007

<First Name> <Last Name>

even entered what the content is <Address Line 1>
H . <Address Line 2=
supposed to be (i.e.: <Last Name>, <City>. =Staten <Zip Code>
<Zip Code>).
Dear <First Name> <Last Name=,

. . We would like to thank you for your donation of $=money= to our Giant
Notice how the variable content Corporation. Itis donations from generous people, such as yourself, that help to
corresponds to the fields in the Keep our business running.
spreadsheet above. It is okay that e will be holding our Annual Giant Corporation Gala at The Really Nice Hotelin

. . Somewhere, State on April 28, 2007 and would love for you to join us there. Per
the wordmg IS not exactly the your request on our donation form, we have enclosed <numbers> ticket(s) to the
same: for examp|e “Address1” and event. If you need more tickets or have any other questions, please do not

“ . " hesitate to give our office a call at 1-800-555-4252.
Address Line 1.
Once again, we thank you for your donation and we look forward to seeing you in

April.

Sincerely,
Allison King

VP of People Giving Us Money
Giant Corporation




Opening the Mail Merge Sidebar Wizard

If you are using Word 2003, open your letter in Word and then bring up the Mail Merge
Sidebar Wizard by going to Tools > Letters and Mailings > Mail Merge.

If you are using Word 2007, click on the Mailings Tab on the Ribbon then click on

Start Mail Merge and select Step by ‘Step Mail Merge Wizard'.

Step 1

The sidebar to the right will appear on the right side of the
window, next to your document.

Since | am working on a letter, | will leave the ‘Letters’
option checked and click on ‘Next: Starting document’ at
the bottom of the sidebar.

As you can see, there are other options such as
‘Envelopes’ and ‘Labels’, which will give you slightly
different options as you walk through the steps. No matter
which option you choose, the basic concept is still the
same.

Step 2

At this step nothing needs to be done, because | already
have the document that | want to use open. Leave the
‘Use the current document’ checked and click on

‘Next: Select recipients’ to move on.

If you have not created your letter already, use this step to
do so by selecting either of the other two options shown.

If, instead of a letter, you were merging to labels or
envelopes, this step would give you the option to select the
type and size of labels or envelopes, such as Avery 5160
labels.

§Mail Merge v X
@ DA

Select document type

\What type of document are you
working on?

@ Letters
() Envelopes
() Labels

() Directory

Letters

Send letters to a group of people.
You can personalize the letter that
each person receives.

Click Next to continue,

Step 1 of 6

# Next: Starting document

Select starting document

How do vou want to set up your
letters?

(®) Use the current document
(O start from a template
C' Start from existing document

Use the current document

Start from the document shown
here and use the Mail Merge wizard
to add recipient information.

Step 2 of 6
® Mext: Select recipients

@ Previous: Select document type




Step 3

This is the step in which the data source is linked into the

Word document. Select recipients

As you can see there are three options for this: ‘Use an © Use an existing lst

existing source’, ‘Select from Outlook contacts’, and ‘Type O select from Outlook contacts
a new list'. O Type a new list
| would caution against using the ‘Type a new list’ option as Use an existing list
the list it creates can often be difficult to manage. To use Use names and addresses from a
the Outlook contacts, you must already be using a Fie or a database.
Microsoft Outlook address book, so if you do not already 7] Browse...
use Outlook for your e-mail, then this option will not work )
for you. :
. , . . o . Step 3 of 6
This leaves the first option, using an existing list. This is = nil ‘
why I'd already entered the data | wanted to use into a @ Next: Write your letter
spreadsheet before | started the mail merge process. @ Previous: Starting document

In order to tell Word where the data source is, click
‘Browse.” Navigate to the folder where your data source is located and double click on
its name to select it.

Because there are two worksheets on the spreadsheet that | selected, the following
window pops up, prompting me to select one.

r

Select Table

Mame Description  Modified Created Type

'donors 20064 2/23(2007 9:30:00 AM  2/23/2007 9:30:09 AM  TABLE
Sheet2$ 2/23/2007 9:30:09 AM  2/23/2007 9:30:09 AM  TABLE

First row of data contains column headers ] [ Cancel ]

Since my data is on the worksheet called “donors 2006” (see Page 2 of this tutorial), |
select that one. As | have column names in the first row of my spreadsheet, | also make
sure that the ‘First row of data contains column headers’ box is checked before clicking
OK.



After selecting the tab that has the data source, another window pops up to confirm the
mail merge recipients. If there is someone on the list that you know you do not want to
receive the letter, then you can uncheck the box next to that person's row. However, in
this case, as with most cases, | want all of my recipients to receive the letter, so | will

just click the ‘OK’ button.

r

=

Mail Merge Recipients @

To sort the list, click the appropriate column heading. To narrow down the recipients displayed by a
specific criteria, such as by city, click the arrow next to the column heading. Use the check boxes or
buttons to add or remove recipients from the mail merge.

List of recipients:

v Last Name | First Name v Addressi  w| Addressz2 v/ City ¥/ S
@] [Adama  [lee  [9887Gemen.. | |Galactica |
Frye Kaylee 607 Airlock St Apt 4 Serenity  FF
Heart Saora 522 Kairi Blvd Disney WD
Jecht Tidus 74 Yuna St. Apt 22 Square  FF
Mouse Mickey & Minnie 1 Disney St. Disney WD
Renyolds Mal 607 Airlock St Apt 1 Serenity  FF
Skywalker Luke 23 Hoth Way Dagoba  SW
Skywalker Leia 25 Hoth Way Dagoba  SW
Thrace Cara 368 Caprica ... Apt 435 Galactica BS
Tam Simon 607 Airlock St Apt 8 Serenity  FF
< >

[ Select All ] [ Clear All ] [ Refresh ]

At this point, instead of ‘Browse’, the Mail Merge Sidebar now
tells me the tab name and data source where Word will be
getting the merge information. If you accidentally select the
wrong source, or if you want to change sources at a later
date, you can click ‘Select a different list’ and browse to it in
the same way you chose the first source.

Clicking ‘Edit recipient list’ will bring up the Mail Merge
Recipients window from above. This will allow you to remove
a specific record or just double check that you selected the
correct set of data for your merge.

Once you are sure that you have selected the correct data
source, then click on ‘Next: Write your letter’ to go to the next
step.

Select recipients
(3) Use an existing list
(O select from Outlook contacts
O Type a new list

Use an existing list

Currently, your recipients are
selected from:

['donors 20064'] in "donors_2006.xls"
& Select a different list...

_:{ Edit recipient list...

Step 3 of 6
@ Next: Write your letter

@ Previous: Starting document




Step 4

Now we get to the fun part, inserting recipient information
from the data source into the Word document. As you can
see, there are a number of different options for types of
items to insert. If you pick any of the first four options, then
Word will match the fields that you have in your data source
to what it believes are the corresponding fields that it has
for the items. This is called “mapping.” However, | have
found that Word does not always get the mapping correct.

Therefore, | always use the ‘More items’ option. This gives
me more control over where and how the fields from my
data source are inserted.

To do this, first select the place in the document where you
want to insert a field from the data source and click on
‘More items’. A box will pop-up, giving you a list of all of the
fields that are possible to insert. (Remember how in Step 3 |
told Word that the headers were in our top row? This is
why.) Select the field that you want to insert and click
‘Insert’. It will replace the selected section of text with
“«field_name».”

Write your letter

If vou have not already done so,
write your letter now.

To add recipient information to
vour letter, click a location in the
document, and then click one of
the items below.

=] Address black...

=] Greeting line...

_f| Electronic postage...
Il Postal bar code...

......

=] More items...

When you have finished writing
vour letter, click Mext, Then you
can preview and personalize each
recipient's letter,

Step 4 of 6

® Next: Preview your letters

@ Previous: Select recipients

February 2, 2007

ST AN E e < ast Name= Insert:
<Address Line 1= O Address Fields
<Address Line 2= Fields:

=City=, <State> <Zip Code=
Last Name
Address1
Address2

Dear <First Name= <Last Name>, | 5%

Zip

We would like to thank you for you) |Denation amt
- ; : # of Tickets

Corporation. Itis donations from ¢

keep our business running.

We will be holding our Annual Giar
Somewhere, State on April 28, 204 |

Insert Merge Field @

(%) Database Fields

help to

Hotel in
Il Fe. Per

your request on our donation form | [ MatchFields... | [ Insert

][ Cancel J to the

event. If you need more tickets or =

hesitate to give our office a call at 1 800 555 4252

April.

—

Once again, we thank you for your donation and we look forward to seeing you in




Here is my letter with all of the fields merged in. Compared to the pre-merged version
on Page 2, you can see that the merged fields are in the same places and have very
similar names (because | called most of them the same thing).

However, if you look at where “<number>" was it now says “«M_of_Tickets».” If you
look at the data field from the Excel file, you will notice that it is titled “# of Tickets.” Malil
merge has trouble converting spaces and some characters and spaces into Word, so it
will replace them with its own formatting. There is no need to worry about this.

Giant Corporation
332 Something Circle
Somewhere, ST 55555

February 2, 2007

«First_Name» «Last_Name»
«Address1s

«Address2»

«City» «State» «Zip»

Dear «First_Name» «Last_Names,

We would like to thank you for your donation of $«Donation_amt» to our Giant
Corporation. Itis donations from generous people, such as yourself, that help to
keep our business running.

We will be holding our Annual Giant Corporation Gala at The Really Nice Hotel in
Somewhere, State on April 28, 2007 and would love for you to join us there. Per
your request on our donation form, we have enclosed «M__of_Tickets» ticket(s)
to the event. If you need more tickets or have any other questions, please do not
hesitate to give our office a call at 1-800-555-4252.

Once again, we thank you for your donation and we look forward to seeing you in
April.

Sincerely,

Allison King

VP of People Giving Us Money
Giant Corporation

Also, note the spacing around the fields. Word will merge in the data exactly where the
fields are placed. So, if you want a space between someone’s «First_ Name» and
«Last_Name», you have to make sure that is there in your document.

Once you have entered all of your merged fields into the correct places and checked the
formatting around them, click on ‘Next: Preview your letters’.



Step 5

At this step you are able to preview your letters to make sure that everything will look
correct once the records from the data source are merged. You can check different
recipients’ letters by using the arrows, look for a specific record by searching the merge

fields, or even ‘exclude’ one from the merge.

At this step | always spot check at least 4 or 5 recipients (depending on the size of my
list) to make sure that all of the merge fields look right. This is how the letter looks with

the information from the first recipient on my list filled in.

Lee Adama
9887 Gemenon St
Galactica BS 45125

Dear Lee Adama,

We would like to thank you for your donation of $550 to our Giant Corporation. It
is donations from generous people, such as yourself, that help to keep our
business running.

We will be holding our Annual Giant Corporation Gala at The Really Nice Hotelin
[Somewhere, State on April 28, 2007 and would love for you to join us there. Per
your request on our donation form, we have enclosed 1 ticket(s) to the event. If
you need more tickets or have any other questions, please do not hesitate to give
our office a call at 1-800-555-4252.

Once again, we thank you for your donation and we look forward to seeing you in
April.

“« O »l¢

Preview your letters

One of the merged letters is
previewed here. To preview
another letter, click one of the
following:

Recipient: 1
3 Find a recipient. ..

Make changes

You can also change your recipient
list:

7 Edit recipient list...

Exclude this recipient

When you have finished
previewing your letters, click Next.
Then you can print the merged
letters or edit individual letters to
add personal comments.,

Step 5 of 6
# MNext: Complete the merge

@ Previous: Write your letter

OB a

As you can see, all of the fields filled in exactly the way that | wanted them to. Note that
because this recipient has nothing in the “Address2” column of the spreadsheet, that
line simply does not appear in his letter. Also, notice how even though the “Donation
amt” is formatted in Excel as ‘Accounting’, the cents are not showing up in the letter. |

will show you how to fix this in Part Il of the tutorial.

A l B | C | D l E | H [ I =
1 First Name Last Name Address1 Address2 City State Zip Donation amt # of Tickets
2 |Lee Adama 9887 Gemenon St Galactica BS 45125 $ 550.00 1
3 |Kaylee Frye 607 Airlock St Apt 4 Serenity FF 01111 $ 100.00 2
4 ara Heart 1272 Kairi Blvd Dicnew wWh 99099 N 100 AN 1

After spot-checking a couple of records, click ‘Next: Complete the merge’.



Step 6
h ith th h ) Complete the merge
_O_ncg you are happy with the way that your merge is set up, Mail Merge is ready to produce
it is time to complete it. You can choose to either print the your letters,

letters or view the merge as individual letters.
To personalize your letters, click

. . . . "Edit Individual Letters." This will

to merge all of the records in the data source, just the merged letters. To make changes
‘Current record’ that you are displaying in the preview, or a E?igai'l'_lgrzl'f:ﬁf&sw't‘h back to the
certain section of continuous records.

Merge
r N S o
Merge to New Document @ &5 Print...
Ly Edit individual letters. ..

Merge records Ch

® A Step 6 of 6

O Current record @ Previous: Preview your letters

O Erom: To:

[ OK ] [ Cancel ]

Note: If you are selecting a certain selection of records from an Excel document,
remember that the first row is the Merge field names. Therefore, if you want just rows 3-
7 in Excel, you need to type in “2t0 6.”

By selecting ‘Print’, Word will send your merge directly to your printer. Each letter it
prints out will have a new recipient’s set of data populating the merge fields (as it looks
in the preview step). Only choose this step if you are 110% sure that everything is
exactly how you want it.

Selecting ‘Edit individual letters’ will open up a new Word document (usually called
“Letters 17). In this document, each page will contain the form letter with one of the
records merged into it. You can then edit individual letters if you want to, for example if
you want to add a message to a specific recipient. It's also a good way to do a final
check that everything is correct before printing. This is my preferred method when | use
mail merge. From this new document, you can just print as normal.

Sometimes there will be a third option: ‘Merge to email’. This option is only available if
you are using a Microsoft email program, such as Outlook, and if you have "e-mail
address" as one of your data fields.

And that’s it. You have now created a mail merge. See? It really isn’t that hard once
you learn the steps.



Part II: Mail Merge on a PC using the Mail Merge Toolbar or Mailings Tab

This is the Mail Merge Toolbar for Word 2003. It can be viewed by going to the menu
bar and selecting View > Toolbars > Mail Merge.

A & | A 2 E | Insert wordField~ | e [ 9% 4 | K 4 9 v w—i\—,’/\;-j;;}ga

The Mail Merge Toolbar can be used to either edit a merge which has been previously
set up or to create a new one (if you don't like using the Mail Merge Sidebar).

A = | The first section is like Steps 2 & 3, creating the letter and choosing
e the data source. You can use the Open Data Source button (second
one) to change data sources in an already merged document. This is very useful if you
have to send out the same letter over and over again, but the list of recipients changes
each time. Just click the button and browse to your new data source.

: =1 The second section is like Step 4, allowing you to add fields from your
NENE | data source. The third button is the ‘Merge Fields’ button which
behaves like the ‘More items’ choice.

The Insert Word Field will be explained in Part I11.

PE | 4 9 » M % | The fourth and fifth sections are like Step

5. To preview a record, click on the ‘ABC’
button. Then you can move through them with the arrow keys or search with the
binoculars. Also, the button next to the ‘ABC’ one will highlight the merged fields, which
gives you yet another way to make sure that everything is in the correct place and
formatted the way that you want it to be.

. The last section is like Step 6, allowing you to print the merged letters or
s &3 E open them in a new document.

10



This is the Mailing Contextual Tab for Word 2007. It can be viewed clicking the
Mailings Tab on the Ribbon.

O H Y9-8 )~ lonors_gala_letter.doc [Compatibility Mode] - Microsoft

3
Home Insert Page Layout References Mailings Review View Add-Ins Acrobat
,i [ = =, — 5 =0 =h - ZP Rules ~ ey |4 4|2 '
: = R
R *;J b @ pp— p— pm— Jq Match Fields «_] Find Recipient
Envelopes Labels Start Mail Select Edit Highlight Address Greeting Insert Merge Preview T - i Finish &
Merge = Recipients ~ Recipient List || Merge Fields Block Line Field ~ Results | < Auto Check for Errors || Merge ~

Create Start Mail Merge te & Insert Fields Preview Results

Just like the Mail Merge Toolbar, the Mailings Tab can be used to either edit a merge

which has been previously set up or to create a new one (if you don't like using the Mail
Merge Sidebar).

—-I The ‘Create’ group lets you create an Envelopes or Labels mail
Envelopes Labels merge.

i . . The ‘Start Mail Merge’ group is like Steps 2 & 3, creating
i D a the letter and choosing the data source. The ‘Start Mail
EJ ) &) y .
o _ Merge’ button lets you start a mail merge or to pull up the
tart Mail  Select Edit . . . . )
Merge - Recipients - Recipient List| Sidebar Wizard. You can use the ‘Select Recipients
Start Mail Merge button to change data sources in an already merged

document. This is very useful if you have to send out the
same letter over and over again, but the list of recipients changes each time. Just press
the button, choose an existing list, and browse to your new data source.

The ‘Write & Insert Fields’ group is

j -j j j =P Rules ~ like Step 4, allowing you to add
2% Match Fields fields from your data source. The
Highlight Address Greeting Insert Merge ‘Insert Merge Field’ button which
Merge Fields Block Line Field ~

behaves like the ‘More items’
choice. The ‘Highlight Merge
Fields’ will highlight the merged fields already in the document. The ‘Rules’ button will
be explained in Part Ill.

Write & Insert Fields

11




¢z Find Recipient
Preview
Results —J/ Auto Check for Errors

Preview Results

The ‘Preview Results’ group is like Step 5. To preview a
record, click on the ‘Preview Results’ button. Then you
can move through them with the arrow keys or search
with the ‘Find Recipient’ button. Don’t forget about the
‘Highlight Merge Fields’ button from the previous
section, which gives you another way to make sure that

everything is in the correct place and formatted the way that you would like it to be.

3 3
AR =
Finish & | Merge to
Merge v | Adobe PDF

Finish Acrobat

The last group is like Step 6, by clicking on ‘Finish & Merge’ you
can print the merged letters or open them in a new document.
You can also choose to merge them to an Adobe PDF.

12



Part Ill: Tips and Tricks

1. Excel formatting

The biggest problem with Mail Merge is that Word will often import the data without any
formatting at all. Remember that the amount in the preview didn’t have cents?

| ran into this problem a lot when | was merging zip codes that started with O (as many
in New England do). Although my zip codes looked fine in Excel, when | brought them
into Word, they would lose the first 0. The way that | dealt with this is to make sure that
the zip code field in Excel was formatted as ‘text’ instead of as a ‘number’ or ‘zip code’.
You may have noticed the little green arrows in the “Zip” column of my spreadsheet

(see below). This is Excel’'s way telling me that | have a
number stored as text.

When | bring up the preview for Recipient 2, who has a
zip starting with a 0, you can see that it appears with the
leading O.

| can correct the money display problem the same way. First, | have to close Word
(because otherwise the computer will consider the Excel file already open and will not
let me edit it). Then | open my Excel file, change all of the entries in my “Donation amt”
column to be formatted as text, and add the cents where needed (there are shortcuts for
doing this, but that's for a different tutorial). As you can see, it looks almost the same in

Excel, but the difference in Word is dramatic.

Kaylee Frye

607 Airlock St
Apt4

Serenity FF 01111

Dear Kaylee Frye,

ss2

City State Zip Donation amt # of Tickets Dear Cara Thrace,

Galactica BS 25 550.00 1
Serenity FF 1 100.00 2
Disney WDN\J93949 100.00 1
Square FF 02200 100.00 1 . .
Disney WD /99999 5000.00 4 business running.
Serenity FF 01111 250.75 1
Dagoba sw 76767 1000.00 1
Dagoba sw 76767 | 1250.00! 3
Galactica BS 45125 200.50 2

ranity cC 1444 2000 00 a2

We would like to thank you for your donation

We will be holding our Annual Giant Corporation Gala at The Really Nig

Somewhere, State on April 28, 20 ould love fory
. we have enclosed 2 ticket(s)
lectinng nlea

your request on our donation for
vnll heed mare tickets ar have any &

2.If...Then...Else

‘If...Then...Else’ statements can also be a really great way of making sure your letter
looks less like a form letter and more like a personalized letter. Look at the, “we have
enclosed 2 ticket(s)” line above. Wouldn't it be better if it said “ticket” when the number
was 1 and “tickets” when it was more than one? Mail Merge lets you do that with the

use of ‘If...Then...Else...’ statements.
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—That help to kee




ask...
I Fill-in... Gala at The Really Nice Hotel i
To insert an ‘If...Then...Else...” statement, I 1. then.. Ee... |0vecl;0rl\%out? J$|nku? there_Per
1 1 1 1 « BAl| CKe ‘—
highlight t_he location in your letter Yvhere ; Merge Record # yi‘iherquegnon'g p?l:as =
you want it to go. Then select the ‘Insert Merge Sequence #  [2
Word Field’ on the Mail Merge toolbar and Next Record
choose ‘If...Then...Else...’ Next Record IF... we look forward to seeing you i
Set Bookmark...
Skip Record IF...
Insert Word Field ~ || 52 =] 2 M 4 9 > MDD

Once it is clicked, an ‘Insert Word Field: IF’ box will appear. In this case, | want to set it
up so that if the number of tickets equals 1, then the document should say “ticket.”
Otherwise, it should say “tickets.” | used the pull down menus to select the ‘Field Name’
“M_of_Tickets” and the ‘Comparison’ “Equals to.” Then | filled out the rest of the boxes
to fit my desired specifications.

" - al
Insert Word Field: IF E]
IF

Field name: Comparison: Compare to:
M__of_Tickets v | |Equalto v |1

Insert this text:
ticket A

Otherwise insert this text:
tickets PN

[ OK ] [ Cancel

Now, when | look at my preview, it will say either “ticket” or “tickets” depending on the
number of tickets entered into the “# of Tickets” column in my spreadsheet.

Dear Cara Thrace,

e would like to thank you for your donation of $200.50 to our Giant Corpor
It is donations from generous people, such as yourself, that help to keep our
business running.

e will be holding our Annual Giant Corporation Gala at The Really Nice Ho
Somewhere, State on April 28, 2007 _and-we join_us there.
vour request on our donation forms

vou need more tickets or have any othera —pleasedo not hesitate tc
niur nffice a call at 1. Q00585 425721
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Part IV: Mail Merge on a MAC using the Data Merge Manager

This is the Data Merge Manager Toolbar for the Mac version of Word. Don't let the
name fool you. It does the same thing as the Mail Merge bars in the Windows version. It
can be viewed by going to the menu bar and selecting Tools > Data Merge Manager.

As you can see, it is very similar to the Mail
Merge toolbar in the PC version of Word.

The first section is like Step 2, selecting the
document type.

The second section is like Step 3, selecting the
data source.

The third section is like the Insert Word Field
from Tips and Tricks.

The fourth section is like Step 4, allowing you
to add fields from your data source. As you can
see, there is no mapping in this version, but
you do have the ability to just drag and drop
the fields into your document.

The fifth section is like Step 5 and works the
same way as the Mail Merge toolbar.

The last section is like Step 6, allowing you to
print the merged letters or open them in a new
document. It even lets you select which
records you want to use right there.
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(@) Data Merge Manager
¥ Main Document

C — Main document: donors_gala_letter.doc
reate
Merge type: Form Letters

¥ Data Source

Get Data ~ (3§

Data: donors_2006.xls
» Word Field

¥ Merge Field

Drag and drop into document:

First_.Name Last.Name Address1

City
Address2 State
z

2P M__of_Tickets Donation_amt
¥ Preview
She M4 4 » M {a]
¥ Merge
B Query Options...
All v




